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Configuring and Troubleshooting
Email and Newsgroup Accounts
Outlook Express is an email and newsgroup client that is installed along with
Internet Explorer. Although Outlook Express is not actually a part of the
Web browser, it integrates with the browser to extend Internet Explorer’s
functionality.

To effectively troubleshoot problems that can arise with Outlook Express,
you should be familiar with performing some of the basic tasks that include
setting up an email account and newsgroups. These topics are discussed in
the following sections.

Configuring Email Accounts in Outlook
Express
Outlook Express is a fully functional email client that seamlessly integrates
with Internet Explorer. It provides many capabilities you would find with
other email clients such as address book and data management. Outlook
Express even integrates with Hotmail, so you can retrieve email from an ISP
and Hotmail (if you have a Hotmail account).

Creating an Email Account
To send and receive email using Outlook Express, you must set up a new
email account. To do so, follow these steps:

1. Click Start, point to All Programs, and select Outlook Express.

2. From the Tools menu, click Accounts. The Internet Accounts dialog
box appears.

3. Select the Mail tab, click the Add button, and click the Mail option.
This action launches the Internet Connection Wizard.

4. Type a display name. This name will appear on any outgoing messages.
Click Next.

5. Type your email address. The network administrator or your ISP pro-
vides this information when you sign up for an account. Click Next.

6. Use the drop-down arrow to select the type of incoming mail server:
POP3, IMAP, or HTTP. Then provide the names of the incoming and
outgoing mail servers (see Figure 3.1). Click Next.
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Figure 3.1 Configuring the names of email servers.

7. Type the username and password for the account. Again, your ISP or
network administrator provides this information. Click Next.

8. Click Finish to close the Internet Connection Wizard.

Configuring Email Account Properties
After you have created an email account, you can edit the properties at any
time through Outlook Express. For example, you can change the display
name that will appear in the From box on all your outgoing messages.

To edit the properties of an existing email account, follow these steps:

1. Within Outlook Express, click Tools and select the Account option.

2. From the Internet Accounts window, select the Mail tab.

3. Highlight the email account you want to configure and click the
Properties button.

4. The properties window for the email account appears (see Figure 3.2).

Be sure you are familiar with different tabs and settings available for configuring an
email account. When troubleshooting email problems, you first should verify that
these settings are correctly configured. Be prepared to encounter exam questions
pertaining to this topic.

From the General tab shown in Figure 3.2, you can change some basic
account information. Under Mail Account, you can type a descriptive name
for the account. You can also configure your name and organization. The
name will appear in the From box on all your outgoing messages. You can
also edit the email address and reply address. If you want users to reply to an
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email address other than the one from which you send, you can type the
appropriate email address in the Reply Address box. If you want Outlook
Express to check for new messages for the email account when sending and
receiving, click the Include This Account When Receiving Mail or
Synchronizing option at the bottom of the window.

Figure 3.2 Open the properties window for an email account.

Using the Servers tab, shown in Figure 3.3, you can configure the name of
the mail servers and authentication information. Under Server Information,
specify the protocol used for your incoming mail server as well as the names
of your incoming and outgoing mail servers.

To receive mail, you must be authenticated. Under Incoming Mail Server,
type the user account name and password for the email account. Select the
Remember Password option to have Outlook Express remember the pass-
word. If this option is not selected, you are prompted to provide the pass-
word when Outlook Express checks for new email. If your outgoing mail
server requires authentication, select the My Server Requires Authentication
option and click the Settings button. In the resulting dialog box, shown in
Figure 3.4, you have the option of using the same credentials used for the
incoming mail server, or you can specify unique credentials.
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Figure 3.3 Using the Servers tab from an email account’s properties window.

Figure 3.4 Configuring credentials for an outgoing mail server.

Using the Connections tab, shown in Figure 3.5, you can configure how
Outlook Express connects to the Internet. If you do not select the Always
Connect to This Account Using option, Outlook Express connects to the
Internet using the settings configured in Internet Explorer. Conversely, you
can override the settings in Internet Explorer and specify the dial-up or LAN
connection Outlook Express should use to connect to the Internet.

Digital certificates verify that you are who you say you are. If you have been
assigned a digital certificate, you can use it to digitally sign all your outgoing
messages. You can configure the signing certificate and encrypting prefer-
ences for an email account using the Security tab, as shown in Figure 3.6.
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Figure 3.5 Configuring how Outlook Express connects to the Internet.

Figure 3.6 Configuring security settings for an email account.

The Advanced tab provides a number of other settings that you can config-
ure for an email account. These settings are outlined in Table 3.1.
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Table 3.1 Advanced Email Account Settings

Setting Description

Outgoing Mail (SMTP) Specifies the port to connect to for the outgoing mail server.
The default value is port 25.

This Server Requires a Specifies whether to use the Secure Sockets Layer protocol.
Secure SSL This option can be enabled for outgoing and/or incoming mail 
Connection servers.

Incoming Mail (POP3) Specifies the port to connect to for incoming mail. The default
value is port 110.

Server Timeouts Specifies how long to wait for a response from a mail server
before stopping an attempt to send or receive mail.

Break Apart Messages Specifies that messages larger than the value identified here  
Larger Than are broken into smaller messages. This option is available

because some older mail servers are unable to handle mes-
sages larger than 64KB.

Leave Copy Messages Specifies that a copy of all received messages are left on the  
on Server mail servers.

Remove from Server Specifies when messages stored on the incoming mail server 
After should be deleted.

Remove from Server Specifies that messages deleted from the Deleted Items folder 
When Deleted from are also deleted from the mail server.
“Deleted Items”

Troubleshooting Email Accounts
One of the most common problems users encounter when using Outlook
Express is the inability to send or receive email messages. Often this is relat-
ed to problems with Internet connectivity (refer to Chapter 7, “Configuring
and Troubleshooting Network Connectivity,” for tips on verifying Internet
connectivity). If Internet connectivity is not the root of the problem, a good
starting point for troubleshooting the problem is to identify the error mes-
sage. This message usually gives you a good indication as to what the prob-
lem is.

If a user is able to connect to her Internet service provider (ISP) or has a
LAN connection but is unable to send or receive email, verify that all the
information is correct within the email account properties window. The set-
tings configured here should match those of the ISP or local mail servers.

If a user reports that a timeout message appears when downloading email
messages, try increasing the server timeout value using the Advanced tab
from the account properties window (refer to Table 3.1).
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Accessing Newsgroups Using Outlook
Express
Another feature of Outlook Express is its capability to function as a news-
reader. A newsreader is required to access newsgroups.

Newsgroups provide a means for people to exchange news, share information,
and voice opinions. Individual newsgroups are normally dedicated to a spe-
cific topic and used by people with common interests. They serve as a type
of message board where someone can post a comment or opinion (depend-
ing on the purpose of the newsgroup) that can be read by anyone else who
accesses the newsgroup.

Accessing Newsgroups Through Outlook Express
Newsgroups are hosted on a server, so the first step in setting up Outlook
Express is to add a newsgroup server. Your network administrator or ISP
provides the name of the newsgroup server.

Follow the steps outlined here to add a newsgroup server in Outlook
Express:

1. Select Tools and click the Accounts option.

2. From the Internet Accounts dialog box, click the News tab.

3. Click the Add button and select News.

4. Type your name and click Next. This name will appear when you post
messages to a newsgroup.

5. Type your email address and click Next.

6. Enter the name of the news server supplied by your ISP or network
administrator. If the news server requires credentials, select the My
News Server Requires Me to Log On option. Click Next.

7. Type the user account name and password that will be used to access
the news server. Click Next.

8. Click Finish.

If a user is unable to send and receive email, there is a good chance that a setting
for the email account does not match those of the ISP. This is one of the first issues
you should verify when troubleshooting such a problem.
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A news server provides various newsgroups that you can subscribe to. After
you have completed the preceding steps, you can view a list of newsgroups
available on your news server and subscribe to the ones that interest you by
following these steps:

1. Within Outlook Express, select the news server you have added under
the folder list. A window appears informing you that you have not sub-
scribed to any newsgroups. Click Yes to subscribe now.

2. The Newsgroups Subscriptions dialog box appears and displays all the
newsgroups available on the news server. Select a newsgroup of interest
and click the Subscribe button.

3. Repeat step 2 for any additional newsgroups you want to subscribe to.
The newsgroups you subscribed to are displayed in Outlook Express.

4. To read the messages posted to a newsgroup, click the name of the
newsgroup. The messages are displayed in the right pane.

Troubleshooting Newsgroups
Most problems with newsgroups are related to users not being able to con-
nect to a news server or not being able to view any newsgroups. You can use
the following points to assist in troubleshooting newsgroup-related issues:

➤ Verify that the user can connect to his ISP.

➤ If a user can connect to her ISP but cannot view any newsgroups, verify
the settings for the news account. The settings configured should match
those of the ISP.

➤ Using the Server tab from the news account properties window, verify
that the correct news server name has been specified. If the user must
log on to the news server, ensure that the correct username and pass-
word are being used.

➤ Verify that the correct port number has been specified. Most news
servers use port 119.

➤ If the connection times out, increase the server timeout value on the
Advanced tab for the news account.
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Resolve Issues Related to
Customizing Outlook Express
Like most other programs, Outlook Express can be customized to meet a
user’s specific needs. Support personnel should be familiar with the different
options available for customizing Outlook Express. Knowing what the dif-
ferent settings are used for helps in determining the cause and solution to a
problem related to customization.

Customizing the View of Outlook Express
If you do not like the layout of Outlook Express, you can alter it to meet your
preferences. For example, if you do not want your list of contacts to appear
on the bottom-left side in Outlook Express, you can configure it not to do so.

To customize the view of Outlook Express, click View and select the Layout
option. You receive the Window Layout Properties dialog box (see Figure
3.7). Here, you can select the different components you want to have visible
within the Outlook Express interface.

Figure 3.7 Customizing the view within Outlook Express.

If you want to be able to view the contents of email messages without having
to open them in a separate window, you can enable the preview pane.
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Customizing Outlook Express Options
Outlook Express offers numerous options that you can use to customize the
email program. From a troubleshooting perspective, you need to be familiar
with the various options to be able to solve Outlook Express–related issues.

Be sure you are familiar with the different settings available for customizing Outlook
Express. One of the best ways to do this is to open Outlook Express and click through
the various tabs.

Sending and Receiving Messages
To access the Outlook Express options, click the Tools menu and select
Options. You receive the Options dialog box, as shown in Figure 3.8. From
the General tab, you can configure how Outlook Express will send and
receive messages. Following are some of the options:

➤ Play Sound When New Messages Arrive—Outlook Express plays a
sound when a new message is received.

➤ Send and Receive Messages at Startup—Outlook automatically
checks for new messages and sends any messages in your Outbox each
time it is started.

➤ Check for New Messages Every—Outlook Express checks for new
messages at the interval you specify. If you are not connected to the
Internet when Outlook Express attempts to check for new messages, you
can remain offline or have Outlook Express establish an Internet con-
nection.

Maintaining Outlook Express
By default, Outlook Express stores a user’s personal message store on the
local computer within his profile. Outlook Express allows you to change this
location. For example, if you want users’ personal message stores to be stored
on a server where they can be backed up regularly, you can change the loca-
tion. To do so, click the Tools menu and select Option. Select the
Maintenance tab and click the Store Folder button (see Figure 3.9). In the
window that appears, you can type the new path indicating where the email
should be stored.
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Figure 3.8 Configuring Outlook Express options.

Figure 3.9 Changing the location of the message store.

As you can see in Figure 3.9, several other options are available for main-
taining Outlook Express. Table 3.2 outlines the various settings.
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Table 3.2 Outlook Express Maintenance Settings

Setting Description

Empty Messages from If this option is selected, Outlook Express automatically  
Deleted Items Folder deletes all messages in the Deleted Items folder when the  
on Exit program is closed. Otherwise, messages in the Deleted

Items folder must be manually deleted.

Purge Deleted Messages Outlook Express deletes IMAP messages marked for 
When Leaving IMAP deletion when you leave an IMAP folder.
Folders

Compact Messages in Messages are compacted in the background, but you can 
the Background still work within Outlook Express. 

Delete Read Message Outlook Express deletes newsgroup messages that have  
Bodies in Newsgroups been read upon exit.

Delete News Messages All newsgroup messages are deleted after they have been 
X Days After Being on your computer for the specified number of days.
Downloaded

Compact Messages Storage files are compacted when the percentage of  
When There Is X Percent  wasted space reaches the value specified.
Wasted Space

Clean Up Now Messages stored on your computer are cleaned up.

You can use the Maintenance tab from the Outlook Express Options dialog box to
enable logging. Outlook Express saves all commands to and from a mail server into
a log file that can be used for troubleshooting.

Configuring File Attachment Security
Most viruses these days are spread through email attachments. Because it is
difficult for users to know attachments may contain a virus, they often open
them mistakenly. Outlook Express 6 allows you to control the file attach-
ments that users are allowed to open.

Although Outlook Express 6 provides a way of blocking certain attachments from
being opened, this feature is not a substitute for running antivirus software.

To configure file attachment security in Outlook Express, click the Tools
menu and select Options. From the Security tab, shown in Figure 3.10, select
the Do Not Allow Attachments to Be Saved or Opened That Could
Potentially Be a Virus option.
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Figure 3.10 Configuring file attachment security.

Although selecting this option does increase security, it may restrict more file
types than you want. Using the Folder Options applet (discussed in Chapter
1, “Configuring, Customizing, and Troubleshooting the Operating
System”), you can select which individual file types can be opened. To turn
off this restriction for specific file types, follow these steps:

1. Click Start and select Control Panel.

2. Within the Control Panel, open the Folder Options applet.

3. Select the File Types tab. Highlight the file type for which you want to
remove the restriction and click the Advanced button.

4. Uncheck the Confirm After Download option. Click OK.

As you can see in Figure 3.10, several other security settings can be config-
ured. For increased security, consider setting the security zone to Restricted.
Also, select the Warn Me When Other Applications Try to Send Mail as Me
option. This setting can help prevent programs, mainly viruses, from access-
ing your address book and sending email to your contacts.

Using Signatures
Outlook Express can be configured to add a signature to all outgoing mes-
sages. You can do so using the Signatures tab, shown in Figure 3.11.
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Figure 3.11 Adding signatures to outgoing messages.

To create a new signature, click the New button and rename the title of the
signature to something more descriptive, making the signature more identifi-
able. Edit the text to display the information you want added to all outgoing
messages. Select the Add Signatures to Outgoing Messages option. If you do
not want your signature added to reply or forwarded messages, clear the box
beside the option Don’t Add Signatures to Replies and Forwards. Click OK.

Working with Identities
Often in a workplace or a home office, more than one user shares a single
computer. Chances are each user will want to customize various programs,
such as Outlook Express, to meet her own personal needs and preferences.

Using the Identities feature in Outlook Express, multiple users can share a
single computer while maintaining their own email separately.

To create a new identity within Outlook Express, follow these steps:

1. Select the File menu, point to Identities, and click Add New Identity.

2. Type the name of the user.

3. Select the Require a Password option and create a password. This step
is optional; however, it increases security.
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4. Click OK. A window appears asking whether you want to switch to the
new identity. If you click Yes, you are prompted to set up Outlook
Express for the new user. If you answer No, you are returned to the
Outlook Express interface.

You can quickly switch between identities in Outlook Express by selecting the
Switch Identities option from the File menu.

Managing Data in Outlook Express
As a desktop support technician, you need to know not only how to set up
Outlook Express, but also how to perform various tasks within the program.
At some point, you will more than likely receive calls from end users request-
ing your assistance on performing a task.

Importing and Exporting Mail
Outlook Express allows you to import and export mail messages to and from
other email programs such as Microsoft Outlook.

To export mail messages, click File, point to Export, and select Messages. In
the Choose Profile dialog box, select the program you want to export your
mail messages to (for example, Microsoft Outlook). From the Export
Messages dialog box, select the folders you want to export and click OK.

To import mail messages, click File, point to Import, and select Messages.
Select the email program you want to import your messages from and click
Next. Select the folders you want to import into Outlook Express and click
Next. Then click Finish.

Managing Email Messages
If you receive a high volume of email messages, you may want to change the
way Outlook Express processes them. For example, you may want messages
from a specific person to be sorted and placed into a specific folder or high-
lighted in a different color.

By creating rules in Outlook Express, as shown in the following steps, you
can change how incoming mail messages are processed:

1. Within Outlook Express, click the Tools menu option, point to
Message Rules, and click Mail.
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2. Select one or more conditions for the rule. For example, if you select
Where the From Line Contains People, the mail message must be
from a specific person before any processing actions are performed (see
Figure 3.12).

Figure 3.12 Configuring rule conditions.

3. After you have specified the conditions, you must edit the value for
each condition by selecting the hyperlink under Rule Description.

4. Specify the actions for the rule. Outlook Express will take these actions
if a mail message meets all the conditions.

5. Edit the values for the actions by selecting the hyperlink under Rule
Description. For example, if you select the rule Move It to the
Specified Folder, you then have to edit the value of the rule and tell
Outlook Express which particular folder mail should be placed in.

6. Type a descriptive name for the rule.

7. Click OK.

Managing Address Books
Most email programs allow you to configure and maintain an address book.
This feature is similar to a traditional paper-based address book where you
store the names, addresses, and phone numbers of your contacts. Using the
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address book included with Outlook Express, you can store the following
information about a person or contact:

➤ Name of the contact

➤ Email address

➤ Physical address

➤ Business-related information

➤ Personal-related information

➤ NetMeeting details

➤ Digital ID information

Users often rely heavily on the contents of their address books for sending
email because the address books contain the email addresses of their con-
tacts. Outlook Express allows you to import and export address book con-
tacts. For example, if a user has address book contacts from another email
program, you can import the contacts into Outlook Express instead of re-
creating all the entries. Conversely, you can also export a user’s address book
from Outlook Express for use within another email program.

To import an address book, follow these steps:

1. From within Outlook Express, click the File menu, point to Import,
and click Address book.

2. Browse to the location of the address book (.wab) and then click Open.

If you are importing an address book that is stored in another format, such as .csv,
click the File menu, point to Import, and select Other Address Book.

As already mentioned, Outlook Express also allows you to export an address
book—for example, if you want to use your existing contacts and informa-
tion within another email program. You can export an address book by click-
ing the File menu within Outlook Express, pointing to Export, and clicking
the Address Book option. Select an export format for the address book and
click Export.
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Compacting Folders in Outlook Express
Outlook Express stores messages as entries within a database. Over time,
these databases can grow in size and, as a result, degrade performance and
consume a large amount of disk space. The reason is that when a message is
deleted within Outlook Express, even if it is removed from your Deleted
Items folder and out of your view, it still consumes disk space. So, over time,
all the hidden records, which you thought were deleted, slow down per-
formance and take up disk space.

Outlook Express allows you to compact your folders, which essentially
removes all the records that have been marked for deletion from your com-
puter. Compacting should improve performance and free up disk space.

By default, Outlook Express is configured to compact folders automatically
during periods of inactivity. You can turn off this feature using the
Maintenance tab from the Options dialog box. However, should you choose
to disable this feature, you should manually compact your folders once a
month. You can do so by selecting the Clean Up Now button located on 
the Maintenance tab and clicking Compact from the Local File Clean Up
dialog box.

If you receive the Cannot compact, folder is in use error message, close down
Outlook Express. Then reopen the application and try running the Compact feature
again.

Blocking Senders
Many users receive unwanted email in their Inboxes. Outlook Express allows
you to control the senders from whom you receive email. For example, if you
continually receive spam email from a specific email address, you can block
the sender. After a sender is blocked, you will no longer receive email from
that sender in your Inbox.

To block a sender, highlight an unwanted message within your Inbox, click
the Message menu, and select the Block Sender option. A message appears
informing you that the sender is blocked. Click Yes to confirm this action.
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Exam Prep Questions

Question 1

You are working as a help desk support technician for a small insurance com-
pany. A new user reports to you that Outlook Express continually prompts her
for a password when checking for new messages. She does not want to con-
tinually have to type in her password. What should you do?

❍ A. Change the security zone using the Security tab from the Outlook
Express Options dialog box.

❍ B. Open the properties window for the email account and select the
Remember Password option on the Servers tab.

❍ C. Open the properties window for the email account and select the
Servers tab. Click the My Server Requires Authentication option.

❍ D. Open the Options dialog box for Outlook Express. From the General
tab, select the Automatically Log On to Windows Messenger option.

Answer B is correct. Outlook Express can be configured to remember the
password for an email account so you are not prompted to type it in when
Outlook Express checks for email. You can configure this setting by opening
the properties window for the email account, selecting the Servers tab, and
clicking the Remember Password option. Answer A is incorrect because a
security zone is used to apply security settings. Answer C is incorrect because
this option is selected if your outgoing mail server requires authentication.
Answer D is incorrect because this option is used to configure Outlook
Express to automatically log you on to Windows Messenger.

Question 2

You are currently using Outlook Express as your email client. You want all mes-
sages from your boss to be placed in a specific folder when they are received.
What should you do?

❍ A. Import all email messages from your boss into the specific folder.

❍ B. Create a rule that moves all email messages from your boss into a
specific folder.

❍ C. Manually move each message into a specific folder after you read
them.

❍ D. Outlook Express does not support this functionality.
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Answer B is correct. To change how Outlook Express processes received mail
messages, you must create a rule. A rule can be created to move all messages
received from a specific person or email address into a specific folder. Answer
A is incorrect because the Import function is used to import mail messages
from another program into Outlook Express. Outlook Express does allow
you to manually move individual messages into a different folder. However,
doing so would require more effort than creating a rule that will do it auto-
matically. Therefore, answer C is incorrect. Answer D is incorrect because
rules in Outlook Express allow you to configure how received mail messages
are processed.

Question 3

A user reports that Outlook Express is performing slowly. Upon investigation,
you also discover that the user has limited disk space. You want to improve
application performance while, at the same time, reclaim some of the wasted
disk space. What should you do?

❍ A. Empty the Deleted Items folder.

❍ B. Compact the messages using the Maintenance tab from the Options
dialog box.

❍ C. Clear the Temporary Internet Files folder using the General tab from
the Internet Options dialog box.

❍ D. Export all the user’s messages from Outlook Express.

Answer B is correct. By using the compact feature in Outlook Express, you
can reclaim wasted disk space and improve application performance. When
folders are compacted, messages marked for deletion are removed from the
computer. Answer A is incorrect because this will not purge all unwanted
information from the computer. Deleted messages are removed only from
the user’s view. Answer C is incorrect because the information stored within
the Temporary Internet Files folder is used for browsing the Internet.
Clearing the contents of this folder will free disk space but not improve per-
formance of Outlook Express. Answer D is incorrect. The export function is
used to move messages from Outlook Express into another email program
such as Outlook.
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Question 4

You are the help desk technician for a small consulting firm. One of the users
recently received an email message with an executable attachment. You want to
prevent users from opening attachments that could be potentially harmful. What
should you do?

❍ A. Have users forward all email messages with attachments to you before
opening them.

❍ B. Change the program used to open executables to Outlook Express.

❍ C. Using the Options dialog box, configure Outlook Express to block
attachments that could be potentially harmful.

❍ D. Using the Options dialog box, configure Outlook Express to notify you
when another program attempts to send an email.

Answer C is correct. Outlook Express can be configured to block attach-
ments that can be potentially harmful to a computer. You can enable this
option by using the Security tab within the Options dialog box. Therefore,
answers A and B are incorrect. Answer D is incorrect because this option is
used to prevent viruses from sending email to contacts in your address book.

Question 5

You are working as a support technician for an Internet service provider. A home
user calls to report that she is unable to send and receive email. However, she
can successfully browse the Internet. You verify that the user is logging in with
the correct username and password. What else should you do?

❍ A. Verify that the user’s modem is working correctly.

❍ B. Verify that the settings for the dial-up connection are properly config-
ured.

❍ C. Check the email account properties to verify that they match those of
the ISP.

❍ D. Verify that Outlook Express is configured to check for new messages.

Answer C is correct. When you are troubleshooting email problems, one of
the first things you should do is verify that the settings configured for the
email account match those of the ISP. For example, make sure the user has
specified the correct name of the POP3 server. Answers A and B are incor-
rect because it has already been established that the user can browse the
Internet. Answer D is incorrect because Outlook Express is unable to con-
nect to the mail servers.
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Question 6

A user calls to indicate that he has been recently receiving a large amount of
spam email in his Inbox. This unwanted email is received several times through-
out the day and must be manually deleted. The user is concerned that some of
the emails may contain viruses and does not want to receive them anymore.
What should you do?

❍ A. Create a rule that places all email from the sender into another folder.

❍ B. Configure Outlook Express to automatically empty the contents of the
Deleted Items folder when it is closed.

❍ C. Block the email address of the sender.

❍ D. Create a rule that places all incoming email from the sender into the
Deleted Items folder.

Answer C is correct. If the user does not want to receive any email from the
sender, the sender’s email address should be blocked. Any email from a blocked
sender will not be received. Therefore, answers A, B, and D are incorrect.

Question 7

You are troubleshooting an email problem for a user. When the user attempts 
to receive email, the error message shown in the figure below. What should 
you do?
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❍ A. Verify that the user is typing the correct password from the email
account properties window.

❍ B. Check that the username is correct from the email account properties
window.

❍ C. Check that the name of the incoming mail server is correct from the
email account properties window.

❍ D. Verify that the user is connecting to the default POP3 port of 120 on
the mail server.

Answer C is correct. The error indicates that the incoming mail server can-
not be found. One of the first things you should check is that the name of the
incoming mail server is correctly configured. Answers A and B are incorrect
because the error message does not indicate a problem with authentication.
Answer D is incorrect because the default POP3 port is 110. You can see by
the error message that the user is connecting to the correct port.

Question 8

One of the users in your organization has a home office. He is able to receive
email from his home or office computer. However, he reports that any email he
receives on one computer is not available on the other computer. What should
you do?

❍ A. Instruct the user to forward a copy of all received emails to himself.

❍ B. Have the user work offline when in his home office.

❍ C. Using the General tab from the Outlook Express Options dialog box,
configure Outlook Express not to connect to the Internet when check-
ing for new messages.

❍ D. Using the Advanced tab from the email account properties window, con-
figure Outlook Express to leave a copy of all messages on the server.

Answer D is correct. Outlook Express can be configured to store a copy of
all received email messages on the mail server (if the server permits this).
The received email messages can then be available from both computers.
Therefore, answers A, B, and C are incorrect.
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Question 9

You have set up Outlook Express for a new user. She can successfully send and
receive email. The user calls you in regards to the Outlook Express interface.
She wants to be able to view the content of received messages without having
to open each one in a new window. What should she do?

❍ A. Open the Windows Layout Properties dialog box and enable the pre-
view pane.

❍ B. Open the Options dialog box for Outlook Express and enable Outlook
Express to go directly to the Inbox when started.

❍ C. Open the Options dialog box for Outlook Express and enable Outlook
Express to display folders with unread messages.

❍ D. Create a new rule that displays the preview pane for all received mes-
sages.

Answer A is correct. To display the preview pane, you must open the
Windows Layout Properties dialog box and enable the preview pane.
Therefore, answers B and C are incorrect. Answer D is incorrect because
rules are used to configure how Outlook Express handles incoming email.

Question 10

Users in your company currently use Outlook Express. However, all users are
being migrated to Microsoft Outlook. You want to move email messages from
Outlook Express into Microsoft Outlook. What should you do?

❍ A. Use the Export function of Outlook Express.

❍ B. Use the Save As function within Outlook Express and save all mes-
sages into a .pst file.

❍ C. Import the messages into a .pst file. Import the messages into
Microsoft Outlook.

❍ D. Back up the mail messages and restore them in Microsoft Outlook.

Answer A is correct. You can use the Export function within Outlook Express
to copy all mail messages (as well as the address book) into Microsoft
Outlook. Therefore, answers B, C, and D are incorrect.
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